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ArchiveReview™ 
 
 
Introduction 
 
Archive disks and tapes recorded on an Eventide logging recorder can now be played on 
any PC or laptop computer equipped with the appropriate archive drive and Eventide's 
new ArchiveReview™ software.   This invaluable option provides playback capability at a 
convenient location away from the recorder itself.   
 

Hardware Requirements 
 
• CPU:  Intel Pentium with MMX, 233 MHZ or better. 
 
• RAM:  64 MB. 
 
• Archive drive:  Eventide-approved DVD-RAM or DDS 

drive with SCSI connection. 
 
Software Requirements 
 
• Microsoft Windows 95, Windows 98, Windows 98SE, 

Windows NT 4.0 with Service Pack 3 or greater, 
Windows 2000, or Windows XP. 

 
• Eventide ArchiveReview™ software supplied on CD. 
 
• Adaptec ASPI library (supplied with ArchiveReview™ 

software; included with Windows 98 and NT). 
 
Installation Instructions 
 
1. Automatically launch the Eventide setup program by inserting the ArchiveReview™ 

CD-ROM into your CD-ROM drive. 
 
2. Follow the instructions as indicated to advance through the installation. 
 

Some choices will be: 
 

Confirm that ArchiveReview may be placed in your Program Files directory.   Click 
Continue or select a directory other than: c: /ProgramFiles/Eventide/ArchiveReview.   
 
The setup program looks for Adaptec’s ASPI software.  If ASPI is not already 
installed, Adaptec’s setup program will launch.  Agree to all queries until the end.   
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Do not reboot at the end of the ASPI installation; instead click Cancel. The 
installation typically takes a few seconds. 
 

3. Click Restart then Finish to complete the installation.  
 
The Eventide setup program will automatically reboot the computer and place an 
ArchiveReview icon on 
 
First-Use Instructions 
 
There are two tasks to perform before using the program: 
 
1. An Administrator Account must be established.  The Administrator has the capability 

of creating, deleting, and modifying user accounts.   
 
2. The DVD-RAM or DDS drive must be identified to the program. 
 
Double click the ArchiveReview icon to launch the program.  The following screen will 
appear; click OK to continue. 
 
 
 
 
 
 
 
Enter the program for the first time 
 
 
 
 
 
 
 
 
 
 

1. Type the default name and password in the appropriate boxes.  Note that these 
items are case sensitive; be sure to use lowercase letters only. 

 
 
 
 

2. Disregard the “Number of channels” (this item will be covered in greater detail 
later on).   

 
3. Click OK to access the “Create First Admin Account” screen. 

 
4. You have now disabled the default name and password and entered the 

program.  The next step is to establish an Administrator Account. 
 

Default Password = password 
(Note: invalid after first use) 

Default Name = eventide 
(Note: invalid after first use) 
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Create Administrator Account 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Type in the Administrator Account information.  The Login Name and Password are case 
sensitive.  The next time you access ArchiveReview™ you will be required to enter the 
 
user name and password in the exact same manner as you have typed it here.   
 
There are no minimum or maximum character requirements for the password; you may 
use any combination of numbers, letters, and/or symbols. 
 
The default settings allow the Administrator full access to all channels and activities.  
Click Accept Changes to store this new information and disable the default password.  
The program will now close and display the following screen. Click OK to exit the 
program.   
 
 
 
 
 
 
 
Continue by double-clicking the ArchiveReview icon.  Type the new Administrator name 
and password in the Login dialog box. 
 

DON’T FORGET YOUR USER NAME AND PASSWORD 
 
For your security, we are unable to provide a “back door” into this program.  Reinstalling 
the software will not give access without a valid user name and password. 
 
 
Select the SCSI device 
 
Now that you are running the program for the first time, select which SCSI device you 
would like the software to read.  Often there are several drives from which to choose: 
these floppy and/or optical drives will appear in the “Select Drive” window.   
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1. From the File menu, click Select Drive. 
 
 
 
 
 
 
 

2. Choose the appropriate drive, and then click OK.  The drive information is now 
stored and automatically chosen when the program is opened. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Change the SCSI drive read by the program at any time by repeating steps 1 and 
2. 

 
Creating User Accounts and Setting Access Permissions and Restrictions 
 
The Administrator stores user names and passwords, and can choose to allow or deny 
access to such features as .wav file creation and specific channels.   
 
1. Log in to the program using an Administrator name and password. 
 
 
 
 
 
 
2. Go to the User pull-down menu and choose “Administrator.”  Note:  If the 

Administrator option is not available, it is because the user does not have 
Administrator access. 

 
 
 
 
3. Choose Create User Account to add a new user account.  To view the account of an 

existing user, or to modify or delete an existing account, first highlight the required 
user and then click on the appropriate option. 
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The instructions for using the Create User Account and Modify User Account options are 
virtually the same.  Enter a user name in the Login Name field.  Enter, and then reenter 
the password for that user in those fields.  Choose the appropriate permissions and 
channel access options, and then click Accept Changes to store the account. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. A check mark in a Permissions box indicates user access to that option.  A 
“depressed” channel number indicates the user has access to that channel. 

 
2. A virtually unlimited number of User Accounts can be created.  No delays or 

problems were experienced in our tests running the program with over 100 User 
Accounts entered.   

 
Log in 
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Name and Password 
 
To log in to ArchiveReview™ the user must an established account that includes name, 
password, and an access restrictions/permissions profile.  The software allows three 
unsuccessful login attempts before displaying a “Login Failed” window.   
 

REMEMBER 
 

You must enter a name and valid password in exactly the same way as entered 
when establishing the account.  Both the name and password are case 
sensitive. 

 
Number of channels 
 
There are from one to 48 channels recorded on each archive medium.  ArchiveReview™ 
allows the simultaneous playback of any number of channels.  Most monitors don’t have 
the resolution required to show more than 10 or so channels at once.  Because of this, 
during each log in the user may choose how many channels to show in the playback 
window for that session. 

IMPORTANT 
 

The number of playback channels is unrelated to the channel numbers stored on the 
media.  Each playback channel can be assigned to any one of the up to 48 channels 
recorded 
Search and Play  
 
The ArchiveReview™ main window is a large dialog box with several groups of controls 
to assist with the search and playback of archive data. 
 
 

IMPORTANT 
WRITE-PROTECT YOUR MEDIA BEFORE LOADING 

 
 
The program will automatically display a warning if the media is not write-protected. 
Even though ArchiveReview™ will not write to the media (it is read-only), it is imperative 
that the media be write-protected before continuing. 
 
Windows Explorer does not recognize the data recorded to the media by the logging 
recorder.  Under certain circumstances the user may be prompted to format the disk.  
This is potentially disastrous because formatting will permanently delete the archive 
data.  This is completely preventable if the media is write-protected. 
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Transport buttons Icons similar to those found on most VCRs. Easily play, stop, rewind, 

and fast-forward by clicking the appropriate button. 
 
Date and Time  Displays the date and time of the current position in the archive. 
 
Archive Media identification showing the logger serial number followed by the 

media serial number. 
 
Begin and End The start and stop times recorded on the loaded archive. 
 
Volume control Slide the indicator to set the overall volume level. 
 
Speed control Slide the indicator to slow down or speed up the playback audio.  

Click Pitch to maintain the correct pitch when the playback speed is 
adjusted.  Click Pitch again to disable this feature. 

 
Search Click Back and Next to skip through messages.   
 
GoTo Opens a Search dialog box with time and date fields and the ability to 

go directly to the beginning or end of the archive. 
 
 
 
 
 
 
 

 
Channel number Displays which logger channel has been assigned to each location. 
 
Assign button Click Assign to assign a recorded channel to the corresponding 

location. (Four of a possible 24 locations are shown in the above 
example.) 

 
Mute button Click Mute  to mute the output from the corresponding channel. Muted 

channels will not be included in “Back” and “Next” message searches. 
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Solo To play a single channel when multiple channels are assigned for 
playback, click Solo. 

 
Volume  Slide the indicator to adjust the individual channel’s output volume. 
 
Pan Sets the output balance from far left to far right on each channel.  

Particularly convenient if, for clarity, you wish to hear two channels 
simultaneously, each played through its own speaker. 

 
Description Displays the channel descriptor from the loaded media. 
 
Channel Activity Window 
 
The Channel Activity window can be dragged anywhere on the screen or may be hidden 
by using the command found under the View menu.  This window automatically displays 
the number of channels that exist on the media.  If the archive was recorded on an 8-
channel logging recorder, only 8 channels 
be displayed.  The example below shows the activity of media recorded on a 48-channel 
logging recorder. 
 

NOTE 
Move the cursor over the channel number to view a description of the 

channel. 
 
 
 
 
One of three indicators will show next to each channel: 

 
Red circle: Data appears on that channel.  Note:  This does not necessarily mean 

that audio is present.  Some channels are set to record continuously even 
if there is no audio. 

 
Grey circle: No data on that channel. 
 
No circle: The user is denied access to that channel. 

 
 

Time Display Window 
 
 
 
 
 
The Time Display window shows the time associated with the current playback of the 
archive.  It may be dragged anywhere on the screen or hidden by using the command 
found under the View menu. The user may size this screen as small or as large as the 
computer monitor allows.   
 
Change the Time Display colors by clicking View from the File menu, then clicking 
Colors.   Choose the desired Text and Background colors, and then click OK. 
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Call Records Database 
 
Transferring Call Records  
 
The program will automatically recognize call records stored on the archive and prompt 
the user for instructions to transfer those records to the PC.  When prompted, click Yes 
to transfer the call records. 
 
 
 
 
 
A dialog is displayed showing the serial number of the logging recorder on which the 
archive was recorded, the serial number of the archive, the number of call records and 
the beginning and end times on the media.  Click OK to start the transfer of the entire 
database. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Choose a select group of call records for transfer by clicking the Limit Call Record 
Import box and entering the required time and dates in the From and To fields. Click 
OK to begin the transfer.   
A dialog box will appear to display the transfer progress.  Click Stop to halt the transfer.  
 
Call records from a DVD-RAM will load very quickly, however, those from a DAT may 
take an unacceptable amount of time.  Therefore, additional call records can be 
transferred at any time by selecting Load Call records from the Database menu 
Working with Call Records 
 
View call records by choosing Show Call Records and Lists from the Database menu.  
The file menu and playback controls at the top of the window do not change.  The 
channel view at the bottom of the window is replaced by the Call Records Database 
data.   Calls can be searched, filtered, and played from this screen.  Play lists can be 
created in the field above the call records list and then saved and recalled as required. 
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Play calls Double click any call in the database search results window and it will play.  

The fast-forward and rewind on either end of the transport controls will skip 
to the previous or next call on the list. 

 
Filter A large database of communications can be easily reduced to include only 

calls relevant to the task at hand.  Complete some or all of the search criteria 
fields under the Search Parameters and then click Search.  Only those calls 
that fit the selected criteria will be displayed in the search results field.   

 
Working with Play Lists 
 
A play list is a series of calls that have been chosen from the call records database to be 
played in sequence.  Play lists can be saved with user-supplied names and descriptions.  
Saved play lists can be recalled and displayed whenever required, however, only the call 
data is stored, not the audio.  To play a call list, the corresponding archive media must 
be loaded.  
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Select calls Single click on a call in the call records database window to highlight its 
field, and then click Add Selections To List.    The call will be added to the 
Play List window above the call records. Highlighting the first call of a 
series, pressing the shift keyboard key, and then highlighting the last call of 
the series will select that group of calls.  Several non-sequential calls can 
be selected by holding down the control keyboard key while making 
selections with the mouse. 

Once multiple calls have been selected click Add Selections To List.  
All highlighted calls are then added to the play list. 

 
Edit Play List Change the play order of the call list by highlighting a call and clicking 

the Move Up or Move Down key until it is displayed in the desired 
location.  Delete a single call or a series of calls by highlighting them 
and clicking the Delete  key. 

 
Save Play List Store a play list on the PC by clicking the Save button next to the play 

list.  Additionally, the option to Save or Save As is found in the File 
menu.  A dialog box requesting a title and description will appear the 
first time a play list is saved.  Enter a short title that will appear at the top 
of the play list each time it is loaded.  Use the larger field at the bottom 
for a detailed description of the play list. 

 
 
 
 
 
 
 
Load Play List  Previously stored play lists are accessed by selecting Call List 
from the File menu.  Choose to display only play lists created from the currently loaded 
media or all play lists stored on the PC by clicking the circle next to the desired option at 
the top of the window 
 
 
 
 
 
 
 
 

 
Highlight the required play list, and then click Open.  That play list will 
now appear in the play list field of the call records window. 

 
 Create an empty play list by clicking New List and entering a title (up to 

32 characters) and a description (up to 255 characters) in the supplied 
fields. 

 
Permanently remove a play list by highlighting it then clicking Delete . 
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Play Play List To play the call list from the top, click the Play transport control.  The call 
playing is displayed in red. Individual calls may be played out of 
sequence by double clicking the call.   The fast-forward and rewind 
buttons on either end of the transport controls will skip to the previous or 
next call on the list.   The playback may also be controlled with the 
supplied foot pedal.  

 
Working with .wav Files 
 
Communications may be stored as standard .wav files.  These files can be emailed, 
transcribed, or used to reconstruct events by combining individual .wav files into one 
composite file. 
 
Prepare to record a .wav File 
 
1. Search the archive media for the communication you wish to record as a .wav file.   
 
2. Assign the channel(s) you would like to play while recording the .wav file.   
 
3. Mute the channels you do not wish to include in the recording.   
 
 
 
 
 
4. Select Record/Play from the Wave Files menu to access the Wave Files window 

shown on the next page.  (Note:  If you can’t access the options in the Wave Files 
menu, it is because you were not granted permission when the Administrator created 
your user identity.) 

 
Record a .wav File  
 
1. Use the rewind transport button to cue the medium a few moments before the audio 

you intend to record.      
 
2. Click Start in the Wave Files window.  Recording will begin from the moment you 

click Start. 
 
3. Use the Pause feature to avoid recording superfluous audio, such as two-way radio 

static or personal calls that may occur on the channel you are recording.  When 
Pause is clicked, the audio continues to play but is not recorded into the .wav file.  
Click Pause a second time to resume recording. 
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4. Type a description of the .wav file in the Description window.   
 

5. When the audio you wish to record has finished playing, click Stop followed by 
Save. 

 
To exit this window, click Done .   
 
 
 
 
 
 
 
 
 
 
 
 
 
Play .wav Files 
 
1. Select Record/Play from the Wave Files menu to access the Wave Files window 

shown on the next page.  (Note:  If you can’t access the options in the Wave Files 
menu, it is because you were not granted permission when the Administrator created 
your user identity.) 

 
 
 
 
 
2. Click Play in the Wave Files window. 
 
 
 
 
 
 
 
 
 
3. Click Select to see a list of previously recorded .wav files. 
 
 
 
 
 
 
 
 
4. Either single click on the desired file in the Wave File Description column or then 

click Select, or simply double click the desired file.  
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Maintain .wav Files and Create Event Composites 
 
Maintaining .wav files and recreating events from these files are done from the Wave 
File Maintenance window shown below. 
  
 
 
 
 
 
 
 
 
 
 
 
 
Open this dialog box by clicking Files from the Wave File menu on the home screen.  
From this window you may: 
 
• Export .wav files – Place files in a different directory. 
• Search .wav files – Find a file by searching for key words in the description. 
• Delete  .wav files – Permanently remove unwanted files from the database.  
• Edit .wav file descriptions – Modify the text that describes the .wav file. 
• Create Composite .wav files – Combine several individual files into a single file to 

recreate conversations relevant to the same event. 
 
The ArchiveReview™ software sorts the .wav files in alphabetical order.  There are two 
types of .wav files: 
 
Individual File: Audio recorded in a single session using the Record/Play window. 
Composite File: Two or more individual files connected beginning-to-end so that they 

can be played consecutively and without gaps. 
 
The Wave Files column displays the first 15 characters of the user-supplied file 
description.  The complete description appears in the window directly below the column. 
 
Export a .wav File 
 
 
 
 
 
 
 
 
Export a .wav file to another directory by first highlighting the desired file, then clicking 
Export.  The Save As window will open automatically with the default path leading to the 
MyDocuments directory.  This directory may be changed to something more convenient. 
The program remembers the last directory the files were saved to and opens that 
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directory the next time an export is requested.  As with saving any other file, you may 
change directories and file names before clicking Save. 
 
Search for a specific .wav File 
 
 
 
 
 
 
 
 
Click Search for access to the Wave File Search window.  Enter a key word that will 
likely be found in the .wav file description fields, and then click Search.  The results of 
the search will appear in the Results field.  Click OK.  The Wave Maintenance window 
will appear with the chosen file cued-up and ready to play. 
 
Delete a .wav File 
 
 
 
 
 
Highlight the file for deletion.  Click Delete .  You will be asked to confirm that the correct 
file has been selected.  When Yes is clicked, the file cannot be recovered.   Click Yes to 
permanently delete the file, click No to abort the process and retain the file. 
 
Edit Description 
 
 
 
 
 
 
Edit a file description by highlighting it in the Wave Files column, then clicking Edit 
Description.  The window shown above will open.   
 
Type the desired changes, and then click OK.  Your changed text is saved as the new 
description. 
 
Cancel the process by clicking Cancel.  No changes will be saved and the description 
will revert to the original text. 
Create composite files 
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1. Choose either an individual or a composite file from the Wave Files column. 
 

2. Click Add to List>> and the file will appear in the Composite File List column. 
 

3. Add additional files to the column by repeating steps 1 and 2. 
 
To remove a specific file from the list, highlight it in the Composite File List then click 
Remove From List.  This removes the file from the Composite File List but does not 
permanently delete the file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. To remove all files from the Composite File List, click Clear List. 
 

6. When all the files are assembled, click Create Composite to combine them into 
a single file.  You will be asked to provide a description of that file. 
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Other Wave File Maintenance Features  
 
Play a file from the Wave File Maintenance screen 
 
• Double click on a file in the Wave Files column.  It will begin to play 

or 
• Single click on a file in the Wave Files column to select it.  Click Play located in the 

middle of the screen and the selected file will begin to play. 
 
Quickly rewind and fast-forward through the file using the track bar. 
 
Stop playing by clicking on the square button to the left of the track bar.  Resume playing 
by clicking Play. 
 
Distinctions between Individual Files and Composite Files 
 
As different types of files are highlighted in the Wave Files column, notice how the 
information on the bottom right-hand side of the screen changes. 

 
Individual File selected - 

 
• Date Logged shows date and time of the original recording as stored by the 

archived media 
• Duration of the recording is listed 
• Size of the file is shown in kilobytes 
• Unit and Medium serial numbers are referenced 
 
Composite File selected- 
 
The same information is shown with the following exceptions: 
 

• Date Logged is not referenced 
• Unit and Medium serial numbers are not referenced. 

 
Under the Play bar is a field labeled “File.”  This is the code the program generates to 
find and process files.  The computer identifies a Composite File by the word composite 
in the file name. 
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Default Directory Path 
 
Each file generated is automatically saved to a default directory found at the end of the 
path shown in the Path field. Change this directory by clicking Set Default Path and 
entering a new directory name. 
 
 
Foot control 
 
The foot control included with every ArchiveReview™ software package is designed to 
assist with the transcription of archive data.  While transcribing to a word processing 
program, users can replay the last few seconds of data by double clicking the pedal.  
 
Foot control set up 
 
1. Plug the foot pedal into the game port on the sound card. 
2. From the Start menu select Control Panel. 
3. In Control Panel, double click Game Controllers. 
4. In the General tab, select Add. 
5. Select "2-axis, 2-button joystick," and click OK.   
 
Some computers will require that you load your Windows install CD to find the game 
controllers.  In other cases, a reboot of the computer may be necessary.  Follow the 
instructions on the screen. 
 
Foot control use 
 
From the Main Control Window: 
 
Foot Control Up  No effect 
 
Foot Control Down Toggle between Play-from-the-beginning-of-call-list and Stop. 

Composite File selected 

Individual File selected 
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Double Click Press twice in rapid succession to back up 8 seconds (default) 

from the current position, then play.  Change the default time to 
between 1 and 60 seconds by choosing Configure from the File 
menu. 

 
From the Call Records Database Window: 
 
When working with the Call List, playback can be paused using the foot control.  When 
the user toggles between Play and Pause, the audio will begin playing where it left off.   
 
Foot Control Up No effect 
 
Foot Control Down Toggle between Play and Pause. 
 

Double Click Press twice in rapid succession to back up 8 seconds (default) from 
the current position, or to the beginning of the current call, then play.  Change the 
default time to between 1 and 60 seconds by choosing Configure from the File menu. 

 


